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(a:aﬂence in

Automation & Drives:

.S'J'emen;

1.MMC 1 F Uit B

MMC RJEPEI]F PLC AR Bl A fgia, HArH T LUF JLPD PLC 7= :

SIEMENS

FE AR RS
CPU 312C, 16 kB, 10D1 /6 DO 6EST7312-5BD0O0-0AB0 to
onboard 6EST7312-5BD01-0AB0O
CPU 312C, 32 kB, 10D1 /6 DO GES7312-5BE03-0AB0O
onboard

CPU 313C, 32 kB, 24Dl / 16D0O,
4Al/ 2A0 onboard

6ES7313-5BEOD-0ABO to
6EST313-5BED1-0ABO

CPU 313C, 64 kB, 24Dl / 16DO,
4Al / 2A0 onboardC

BES7313-5BF03-0AB0

CPU 313C-2 PP, 32 kB, 16 DI /
16 DO; PtP-SS

6EST313-6BEDD-0ABO to
6EST7313-6BED1-0ABO

CPU 313C-2 PtP, 64 kB, 16 DI /
16 DO; PtP-55

6EST313-6BF03-0AB0

CPU313C-2 DP,32kB,16DI /
16DO;DP-55 M/S

6EST313-6CEO0-0ABO to
6EST7313-6CEQ1-0AB0O

CPU313C-2 DP,64 kB,16DI /
16DO;DP-55 M/S

BEST313-6CF03-0AB0

CPU314C-2 PtP,48kB, 24Dl1 /
16DO / 4Al /2A0 PtP-S5

6EST7314-6BF00-0ABO to
6EST7314-6BF01-0ABO

CPU314C-2 PtP,64kB, 24Dl /
16D0O / 4Al /2A0 PtP-SS

6EST314-6BF02-0AB0

CPU314C-2 PtP,96 kB, 24Dl /
16D0O / 4Al /2A0 PtP-SS

6ES7314-6BG03-0AB0

CPU314C-2 DP,48kB,24D1 /
16D0O/ 4A1 / 2A0 DP-55 M/S

BES7314-6CF0O0-0ABO to
6ES7314-6CF01-0AB0

CPU314C-2 DP,64kB,24DI /
16D0OY 4A1 / 2A0 DP-55 M/S

6ES7314-6CF02-0AB0

CPU314C-2 DP,96kB,24DI /
16D0O/ 4A1 / 2A0 . DP-55 M/S

6EST7314-6CG03-0AB0

CPU 312, 186 kB, 0.2 ms/kAW

6EST7312-1AD10-0ABO

CPU 312, 32 kB, 0.2 ms/kAW

6EST312-1AE13-0AB0D

CPU 314, 48 kB, 0.1 ms/kAW

6EST314-1AF10-0AB0

CPU 314, 64 kB, 0.1 ms/kAW

6EST314-1AF11-0AB0D

CPU 314, 96 kB, 0.1 ms/kAW

GES7314-1AG13-0AB0

CPU 315-2DP, 128 kB, 0.1
ms/kAW

B6EST7315-2AG1

0-0ABO

CPU 315-2 PN/DP, 128 kB, 0.1
ms/kAW

6ES7315-2EG10-0AB0

CPU 315-2 PN/DP, 256 kB, 0.1
ms/kAW

GEST315-2EH13-0AB0

CPU 317-2DP, 512 kB, 0.05

6EST7317-2AJ10-0AB0O
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ms/kKAVW

CPU 317-2 PN/DP, 512 kB, 0.05
ms/kAW

BEST7317-2EJ10-0AB0O

CPU 317-2 PN/DP, 1MB, 0.05
ms/KAVW

6ES7317-2EK13-0AB0

CPU 319-3PN/DP, 1400 kB

G6ES7318-3ELOC-0ABO

CPU 315F-2 DP, 192 kB”

6ES7315-6FF01-0ABO V200toVv2.0.11

CPU 315F-2 PN/DP, 192 kB

GEST7315-2FH10-0AB0

CPU 317F-2 DP, 512 kB, 0.1
ms/kAW

6EST7317-6FF00-0ABOD

CPU 317F-2 DP, 1024kB

6EST7317-6FF03-0AB0

CPU 317F-2 PN/DP, 512 kB

6EST7317-2FJ10-0ABO

CPU 317F-2 PN/DP, 1024kB

GEST317-2FK13-0AB0

CPU 315T-2 DP, 128 kB, 0.1
ms/kKAW

6EST315-6TG10-0ABO

CPU 317T-2 DP, 512 kB, 0.1
ms/kAW

6ES7317-6TJ10-0ABO

C7-613

6EST613-1CA00-0AES to
BEST613-1CA01-0AE3

6EST613-1CA02-0AE3

C7-635 Touch

BEST635-2EBO0-0AES to
6EST635-2EBO1-0AE3

GEST635-2EB02-0AE3

C7-635 Key

BES7635-2EC0O0-0AES to
GESTHE35-2ECO1-0AE3

GEST635-2EC02-0AE3

C7-636 Touch

6EST636-2EB0O0-0AES"

C7-636 Key

6EST7636-2ECO0-0AE3™

6ES7 151-T+*x*x—0ABO ET200S with CPU

3
\

L.

2.

o LLEP ST 505 2 DR 7 SRR (R T s AT A, 7 bR R LU il AL ROl v

FEE LA = S, PLC AR B AN MIC &, FrLICH TIEF ] PLC, & A2 AR 415 145
PRI H SERR 77 3K 8 W — A KNG MIC R, WA PLC BRI MMC &, R2
oK STEPT rh R PP A N 8T £10, [RINMRIY 23R, ANRedis iddidk MMC =, &
W 2% 2% R AR P AR R MC R o

i Simatic manager "1, EFEMREFPHT R, WHZIBE N EE MIC R, WRAEE
PR Y B g b Block STPFIRBEAT T4, WFTHAT IOE T~ 2038 MMC - |, MMC
AT A5 R A o, ) MMC R 1325 B Bl 80 1 R T B 32 B A
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4.

Brit CPU AR SFB/SFCs Hedh, MMC >4 HA FRT B il Bl 72 R MBS o

X HESBCPUH] B ARMMC T (6EST 953-XXX20-0AA0) EFACIHARMMC I (6EST 953-XXX00-

0AAO) I T 22 THRPLCIIOPERATING SYSTEM. THZRIN #5248 HIPG (6EST798-0BA00-

0XA0) BRAFUSBIH 4 fEss (6ES7792-0AA00-0XA0) , JBiLSTEP7 MANAGERT I+ (122

FLIfIHE “PLC/UPDATE OPERATING SYSTEM” #4CPU HD. UPDCA'E #IMMCF |,

CPU_HD. UPDSZ {1 #] LL{Ehttp: //support. automation. siemens. com i I~ #5351,

MMC RAER CPU (R38N AF (Load Memory) , 7E MK CPU ZERY MMC FRI i, FAr ]t

W PTIL I MMC R 58 EERTA5 TRk 2 1K CPU TAE N AF R/ (work memory)

Il LU TAE N AE K28, HIn &N A o, PLC TAER ZAE R M R8s, [

S, T B S e ) L AT AR R T P R . STEPT mH I I D gt
(40 FB41. FB42 %5) I, ZGE] 2—8M (K MMC &, {HiFF R HAT 314, 315—2DP.

C7 &4 PLC SZHF 8M ) MMC .

MMC 2B A AE, T LAANRERSAE EALHL P AR AT vh B2 MMC b R B £
(DB Herp (8t >, ZHASIH [HI B 2 PLC RAM A7 AP (1 2504

FEVG 1T 710 PLC b Z548 I 5 1775 FH 0 MMC &, 0 &R s i ids, A REAE T 2his

FANL. B2 UGBl PDA A5 Hcht = b A FH 11938 A 282 MMIC .

The order numbers for MMC cards are in the following table:

Micro Memory Card / S7-300 Order number

64 Kbytes 6ES7 953-8LF20-0AAQ
128 Kbytes 6ES7 953-8LG11-0AA0
512 Kbytes 6ES7 953-8LJ20-0AAQ
2 Mbytes 6ES7 953-8LL20—-0AA0
4 Mbytes 6ES7 953-8L.M20-0AA0
8 Mbytes 6ES7 953-8LP20—-0AA0
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Auwggrbgng Drives: s I E M E N S

2.MMC & . 0 @i %)%
QUESTION 1 : A/ #f e STEP7 i TR H FH ¥ F 22 K28

MMCE ?
Answer : HEBEFEEIFE T FT AR MMC RHIA/D, BT RLF LR DB 3EAT .
1. fE STEP7 Manager "] JF#E ) Project;
2. BRI, A RASA R (BB ALt + Enter) |, FTFREFHLATE M 0T
1

HSIMATIE Manager - [test -- d:\,Program Files' Siemens' Step 7.5 7proji test]
55 File Edit Insert PLC Yiew Options Window Help

DS 29a | 4 2R dnls 2| % 8|6 NFite MEAES = ull
=3 test 59 System data o OB o} 0BBE o 0B100 % FE7
o SIMATIC 30001] = DETO = D121 AAAT T

=[] crusHCZ PR

=11 57 Pragram{7] Propetties - Block Folder OFfline x|
OLICES s
General ¥ hecksumsl Address priarity: I

r— User program memory

w [ SIMATIC 30002)

_, SIMATIC 30003 Size in load memony;

Size in wark memaony: Code 8328 bytes
Data 1432 bytes
Total 9760 bytes

— Syztem data memony

Size in load mermorn: 1662 bytes

r— Mumber of Block:

0E: 3 SFB: 1]
DB: 4 SFC: 0
FB: 3 UoT: 0
FC: 1] WAT: 1

Cancel Help

3. EEEHHE DA ) Blocks T :

M E B ] DU S AR P B AE PLC o R N A7 1 15 2
4. BT H BT R FEE (0B. FC. FB. DB) (53 M AFE (Load Memory
Requirement) FlRGEHE (Syestem data memory) 7 FHIISE4E N AF KB e —

i
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PR R R R AERR EL 1024, 5t n] BAANIE
MMC =¥ 1A]
5. WM CAAT Siemens (1) PLC FIMMC, HB4f&n] LUB I FEZ 2T, REX PLC TAEPIA7
RN AE (MC ) [R5 0
£ STEPT Manager #L1firf, & CPU, HJ CP5611 BY PC-Adapter #%$% PLC () MPI iR
1, A P
24 MMC RARIEA

Wiew  Option

Ctrl + D, i PLC (M2 WHE A% 1.
PLC i

indow - Help

151 Project W RRE P HeRE 22 K

=B MMC
SE F4CPTP
=@ CPU 314C-20P
= 57 Pragram(1]
(@ Souces
(g8 Blocks

uskAy) TTEPITT

o 287 | ];-*!_II__I .

Statuz: OK Mot & force job

Time System | Perfarmance Data l G
General I Diagnostic Butfer :

0 e ] DP
Path: |MME\3‘I AC-PTPACRU 314C-2 DR Operating mode of the CPU:

W 5TOF
| Stacks |
Scan Cycle Time I

Azsignment:

[sizes in bytes)
Free:
B Assigned:
Total:
Largest Free Black:
Max. Pluggable:

|

Compress | Details Memon Srea

Cloge I Update | Frint... |

Help |

(A& PLC FH A 6\ MMC =,

Load memory RAM + EPROM %1%, Work Memory #1H {27 4 Hij
PLC [f)TAE Y474 48K, EPROM A& S7-400. [HK S7-300 4 I (f) R 8 Py 17+

7E PLC H#E A MMC i,

A PRFERE Cerl

+ D 5 PLC B AR O
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f-] Module Information - CPU 314C-2 DP
Path: |MMEI'\3‘I AC-PTPACPU 314C-2 DP Operating made of the CPU: & STOP
Mot a force job

Statuz: OK
] Perfarmance Data ] Communication ] Stacks ]

Tine System
General ] Diagnostic Buffer Scan Cycle Time ]
Agzignment;
0% 0%

[sizes in bytes] Load memony Rakd + EFROM Work Memony

Fiee: 131,072 49,152

B &ssigned: 0

Taotal: 49152

Largest Free Block: -

b ax. Pluggable: -
Compress Details Memory Area... |

Cloze | Update Frirt... | Help
W LA PLC (AR TS N 0%, 2543 128K 4 A AE AT 48K TAE A7

RS iORE Sy T 3E) PLC 247

K SIMATIC Manager, - [MMC -- D:\Program, R

Ep File Edit Insert PLC Wiew Options winday

eI ) 2

= & MMC Govmiaa]

- FAC-PTR 1=
- CPU 314C-2DF FC100
- 57 Program(1] =+ DE3
(B Sources

o

fEF] Ctrl + D 3 PLC FR N A-AE F I .«
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QZSIMTIE Mannggr [MMC -- D: \Prngram Fllﬂs\SlemensKStepﬂs?prqumc]

MLJ SElEEEE =& =l 1| @) mEm| e

=2 MMC
=-[E 4CPTP T R ; :
=-[§ cru 314c20F | Module Information - CPU 314C-2 DP
=8 S7 Program(1) Path iMME\:ﬂ AC-PTPACPU 314C-2 DP Operating mods of the CPU: @ STOP
(B Sources Statuz: OK Mat a force job
“[£H Blocks : it
Time System i Perfarmance Data I Comrmunication i Stacks I
General ! Diagrostic Buffer Memary I Scan Cycle Time !

Aezignment;

25% - . x
[sizesinbptes] T memon RAM wiork Memary, |
Free: 24,134
B 2ssigned: 25,018
48,152

Total
G 5195 . 9K ] _’_ﬁﬁ,—?

HHE—F 5 F32.1 H’;E[ETJ T

MM[:—F
Q}D Y jig1 28k [
ﬁﬂ"ﬁcpuﬂij\_,ﬁ Compress I Details Memary Area... '

Fiskimc
Cloze i Update i Frint... i Help |

FIUAE BRI P AR PLC Hhont e 28 A7 A CAE N AE IR o A B0

QUESTION 2 : MMC+_E 7 fi 2 Fr B B B 48 B i BR Il A4 7
ANSWER;
I, R mne FIHEH W0 R # A

RH MLFB BZ MR E

MMC 64KB 6ES7953-8LF20~0AAQ 768
MMC 128KB 6ES7953-8LG11-0AA0 1024
MMC 512KB 6ES7953-8LJ20-0AAO 2560
MMC 2MB 6ES7953-8LL20—-0AAQ 6528
MMC 4MB 6ES7953-8LM20—0AAQ 12672

* 1: 1F mme RSN EREL
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QUESTION 3 : {{AMIEEMMCF b 53R B85 2

ANSWER:
RnT LM T A0 B J5 2 ER mme B ¥ % -

1. TR IR mme K46 AE ple HAkE A .
2. 7C SIMATIC B HEPSHLHI (SIMATIC Manager) , ijid”View > Online” Bt &ith

I ——

4. AEELRBEA Ty B Blosks
5. MHRIE T EMIR 0 5.
6. sl b DEL MIRRHEE CMIIRR (E T S AT )

QUESTION 4 : 31XEIPLCHEAMMCE)G, STOPITAENRNLR, E4
7 B WA R AEMMC?

ANSWER:

TE cpu ) mme KA XA BEAFAE cpu LVERBE R (B2 5 h—F ple 80& 5
WA cpu MRAEMRZD

TR

%5040 mme RIS mme T EAR RS K.

%A mme (1525 98

l. Your CPU requests an overall reset (slow flashing of the STOP LED).

1 cpu F 2 5E A AL (STOP ATHEIND .

FORE AL FEIT ICIEFE 1 MRES A7 B I ORFF SR B A EL B AT 52

il ZAE 3 A BOTIEFIT RARSAEIF AL S MRES £7 5, (ERs A R 5 AT &
K

L

W o EERAEA RS U mme 5, BB mme AT REC A UL
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n EJEAAGE R T mme R NEBAAAE AR EX T ple RN DL

QUESTION 5 :#AMMCEHKIS7300 PLCANREIE # A F SFC54 2 /%
He?

ANSWER:

FEH AL S7T-300 cpu " SFC 54 “RD_DPRARM “ L4454 SFC 102 “RD_DPARA”. ITfC%%.

SFC 102 “RD_DPARA”, %Lt J-IHf¥) SFC 54 “RD_DPARM” j& S AHATIN RS UIRE. XE
WREEFEF IR T 21 2 IRIK sfe I AT

{7 SFC 54 "RD_DPARM” FJRE- i R EEMEH] mme R ple b, I#2EH] SFC 102
“RD_DPARA” #:4% SFC 54 "RD_DPARM”, Jf ELAET%J 525 AT 1 M 7> 1) 2
MR T BETLIIRS L -

SFC 54 “RD_DPARM” SFC 102 “RD_DPARA” ijiHH

Inputs
- REQ Y REQ=1 NFEJFHAT; SFC 102 [HIFT S 41
101D - ZSHCAE SFC 102 FEGH; W LADDR
SFC 54: fTAftibhl, ((B#16854=4MAc%i
\; B#16#55= Ahuchait) SFC 102: fTAk
LADDR LADDR
Huhl; LADDR ffi@fz (BIT 15) Bit15=0 —>
AN Bit15=1 —>4hski
RECNUM RECNUM il s
Output

T AR T eSO I
RET VAL RET VAL D3R [P AL A RS . SFC 102 (Ui £

IR AE B
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- BUSY BUSY=1; fF45MiARLEw

PRI AL SR ) HARD IS SR v 7 17
RECORD RECORD

B

ok

i}

o

2 1: SFC 54 A1 SFC 102 [pjx}tk

QUESTION 6 : ZFHMMCE/IS7300 fIC7613, 635 RFICPULEMN
7] 58 LB IR FE T RE A 2

ANSWER:

U HER B AR D BERHE T mme R cpu HAL, 24 ple OB BRERI N B He, B 28
THE g A 1) A B R B R

g

o CPU fE1k/i84T BHE HIE X/FF

Lo R H B i N 50 3 R H R TT/ B AR 2R B . il LUK A%
Frfi s SOVE I K B IRE DR R B L3038 TARAAfd s . A5 V2. 0. 12
MBS A CPU W SRR R R P B AT HHT R 3k
DI USRS TR TIFIN ,  HCREAT AR ORI a9 46 (5 b 8847
fiti G PG AR DR FR R P . nT DU 5 R AR A it 4 P PR R 2B 2
FEORFF S PR AR B

2. BCEARRFPEEE YRR R

o {EHFEYLY JE M ik "Non-Retain”
o J#iL SFC 82 "CREA-DBL”AEIM%dit. ESH ATTRIB H
BIT2 FREWI BRI ORFFIEE, 1 HAREE, 0 R PRER.

o  WHEEALL MRES)

L FEREAAH o 1 N AR & R A N W1 an i
2. AERCHAFHAT N IIHRAAR, AR N A RO EUE AL A WG 1.
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ﬁ.aﬂe&n;e‘m
et inec ) SIEMENS

o CPU Wit > ¥F —> bW > Wi > EF > kW

L. BT R R Ar s v B, BB N gm A T 23 epu AEUE,
a5 % SFC84 B N AU -

2. A PR FE AR . 75 TAE A BB AG 1L o

Note:
Uty EORFF MR, W] SFC84 LRAFEEAE mme A, VER MMC R R it
4T 100, 000 G V5]

MEX, THEasER8s:

XA W] LR A W REAT BOE IR FF i AR ORYF: - “Object properties CPU >

remanence”.

e CPU STOP/RUN % HiyE OFF/ON
W e N IREE, B S RE, BNSPERILGEEAs o.

e WHFEANL (MRES)
IXEEAF B ATE R, B BOE R FRE S AR

e CPU Power OFF -> Remove MMC -> Power ON —-> Power OFF -> Insert MMC ->
Power ON
T S A DR FE I LR B A5 W) as A ok 0

QUESTION 7: 73 R i J& AR R AT AR 2

ANSWER:

FERRYEIR B b JE R A" General — Part 27 FRAETT. T DUB I I WUHEAT (R k2
(AL -
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Propetrties - Data Block

General - Pat 1 General - Part 2 | Callz I Attributesl

x|

MName [Header): I
FEarnily: I

Yerzion [Header|: ID.'I
Author; I

—Lengths
Local D ata:
[ata: 0 bytes
Load tMemory Beguirement; 80 bytes
whork, Memomn Beguirement: 36 bytes

[~ DB is write-pratected in the PLC

[~ Enow-how protection

[~ Standard block
[ Unlinked

Cancel Help

Fig. 1: J&thk - Hadk

T cpu CHFIZIDRE

Note:

CPU 317-2DP [f] ram & 512 KB, Hf5 256 KB fi

IREF.

QUESTION 8 : Fin{a s — L R 55 U4 B2 B B A5 5% B SCAEFr i 2

MMC_L?

ANSWER:
A HT LIRS AR A L5 100 AHSC IR SCARA7 A 21 MMC R AL

W

e ¥ mmec RIEAF PG H.
e #TJF SIMATIC-Manager.

o EFEZE "File > ST-Memory Card > Open”.

o EFFIEHE"PLC > Save to Memory Card .

”

A&D Service & Support
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JSIMATIE Manager - 57 memory card

File Edit Insert | pLC  “iew Options ‘Window Help

D|ﬁ’r| §?|ﬁ

~{£H 57 memarn

Access Rights

Donload

Zampile And Download Ghjects

lpload

plead Station

Copy Rak ba RO, .

bovnload user program be memary: card

CErlLL

Retrieve from Memory Card. ..

Manage M Systenm...

Display Accessible Modes

R Messages,..
Display Force Yalues
fanitorModify Yariables

DiagnosticfSetking

PROFIEUS

Assign Ethernet Address. ..
Assian PEEEC

Zancel PE/PE assignment
Update Operating System. ..

<MoFi

K. 1:

o

SIMATIC Manager — S7 memory card

o IEFTELAFKISCAIALN "> BEHEAT AT

A&D Service & Support
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HSIMHTIE Manager - 57 memory card
File Edit Insert PLC  Wiews Options wWindow Help

D[] 32)&m| & =] bl o 2| )i &

EST memory card
{EH 57 memoary card
Save files to Memory Card il

[ < NoFiter> 19| =l &

~STEF 7 Data

Frojects/Libraries... |

r Other files

Search in: I[ﬁ:' MTEF ﬂ

DM TBFwpdate_11.x#lz

update_11

I Ok, | Cancel | Help | I

o UWRTFEMIBRIEREMSCAE, A<
. siili OK FHRARAT
o RAFEIMEPE W RTE”ST Memory Card” % .

QSIMHTIE Manager - 57 memory card

File Edit Insert PLC Wiew Options Window Help
] = T e

..... .ﬁ ST TREFRon, card update_'l 1.xls

K. 3: frfiER3gm
Note:
IIEEALBE T S7-300 ¥ mme K1 S7-400 [ Flash .
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QUESTION 9 : F&ABM IR KISTEP? T B BB HARFEEMMCE £, %

EHEL KKIMMC?

ANSWER:

N T IEFER Z I mme R, B TR IUH KN, ATRE W R A

e STEP 7 I H AR, “File > Archive”. #RJ5 f & ARG 1 @t Gl A7 B ek

FALtHR A

test.zip Properties

General |Securil}l| Sunnmary

x|

Ilest.zip
Type of file:  WinZip-D atei
Openz with: @ WinZip Executable LChange... |
Location: H:\FAQ-Daten
Size: 393 KB [403.340 bytes)
Size ondigk: 396 KB (405,504 bytes) |
Created: Freitag, 13. Dezember 2002, 13:18:01
b odified; Freitag. 13, Dezember 2002, 13:15:08
Accerzed: Freitag. 13, Dezember 2002, 131331
Attrbutes: l¢ T Hidden ¥ Archive

QK. I Cancel

Apply

K. 1 SO

#E#FEPLC > Module Information > Memory”. %8 0] L ) O 24F H HIAEAE /.

A&D Service & Support
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(.a;aﬂe&nge‘m
et ) SIEMENS

& Module Information - CPU 315-2 DP ONLINE P im] B3
Path: |Acce&&ible ModeshbPl = 2 [directiy) Operating mode of the CPLU: <$> RUM
Status: OF Mat a force job
Timne Suskemm I Performance Data | Communication I Stacks I
General I Diagnostic Buffer Scan Cucle Time

Azzignment;
[sizez in bytes) 4% ik
Load memary Bak + EPROM whark Memary|
Free: s 118.800
B &:signed: 12272
Total: 131.072

Largest Free Block:
Max. Pluggable:

Compress | Detailz Memony Area... |
Cloze I Update I Frrint. .. Help |
C20 BEEUNAE

e A AR E s 1 AN C AT P REAT AR N, 15 21 1 25 FAROR I PR R A7 3N T H iy 75 5L
(1] mme R R

25

T

1

oS
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QUESTION 10 : ZXHEAMMCRES7300PLCH#AT T IN%, (EHHS
0T E, WA BEXMMCHEZ, ERMIBRMMCF LD ?

2 IR T #AEST-300CPU Protection@ kb B i (51, 4 M K AEhs %1
siemens[AI4FERSPG (6EST798-0BA00-0XA0) ¥y iR A8 ali R F AP USBEE I s 4% (USB
prommer 6ES7792—-0AA00-0XA0) , FEFESIMATIC Manager Fti RIS E.  File>S7 Memory
Card->delete MEMUMIERMIC K LA AN ZS, XFEMMCH AT LA —AS AR R0 1,
{RTEIENIMMC-RHEAT fift %, LEOMMC R R 2 P B A
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H 35 XS & 7RSS 5 S RE L

M5 T hitp://www.ad.siemens.com.cn/Service/

LR HEAERS W0 http://www.ad.siemens.com.cn/Service/recommend.asp

ASH 0] ] @:  http://support.automation.siemens.com/CN/view/zh/10805055/133000
ASH {5 B http://support.automation.siemens.com/CN/view/zh/10805055/133400
“HAEE” ASHRIX: http://www.ad.siemens.com.cn/service/answer/category.asp?cid=1027
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